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Laura Stack, MBA, CSP is America’s premier expert in
productivity. For over 20 years, her speeches and seminars have
helped professionals, leaders, teams, and organizations improve
personal productivity, performance, and potential. Her Denver-
based company, The Productivity Pro, Inc., provides time :
management workshops around the globe to help attendees A\ =z A
achieve Maximum Results in Minimum Time®. Laura was the ’

2011-2012 president of the National Speakers Association. N, A
Keynoter \
Laura presents over 80 practical, high-energy keynotes and
seminars each year on improving output, lowering stress, and
saving time in today’s workplaces. She is one of a handful of
professional speakers whose business focuses solely on personal
productivity topics. Laura is a high-energy, high-content Clients include
speaker, who educates, entertains, and motivates professionals Starbucks Sodexho
to improve workplace performance. She has earned the e Ball Aerospace
Certified Speaking Professional (CSP) designation, the highest
earned designation given by the National Speakers Association. Wal-Mart Quest
Auth Cisco Systems  U.S. Bank
uthor

KPMG McDonald’
Laura is the author or coauthor of 10 books, including What to _ . c-onaids
Do When There’s Too Much to Do; SuperCompetent; The Nationwide Nestle
Exhaustion Cure; Find More Time; and the bestselling Leave the MillerCoors EMC
Office Earlier: Her newest book, Execution IS the Strategy,. will hit Sunoco Oppenheimer
bookstores in March 2014. Her books have been published in .
twenty countries and translated into seven foreign languages, iyt Uime e
including Japanese, Spanish, Korean, Chinese, Taiwanese, ltalian, MCI Wells Fargo
and Romanian. Laura is a columnist for Training, Productive, Sprint Vi
Time Management, and Success magazines. e RE/MAX
Recognized Productivity Expert Lockheed Denver Broncos
Widely regarded as one of the leading experts in the field of
employee productivity and workplace issues, she has been Spokesperson
featured nationally on the CBS Early Show, CNN, NPR, Mi « X
Bloomberg, WB News, the New York Times, USA Today, the Wall croso erox
Street Journal, the WashingtonPost.com, Entrepreneur, and 3M Day-Timer
Forbes magazine. Laura has been a spokesperson for Microsoft, oVC Office Debot

3M, Skillsoft, Office Depot, and Xerox.
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Task: Something You Need “To Do” that Does NOT Need to be
Completed at a Specific Time

A. Create a New Task with Complete Information.

1. Click on Tasks in the Navigation Pane
2. In the New group, click the New Task button.

Fill in as much or as little as you wish; we’ll cover the fields in this top section first. The
tab key moves you through the fields in this order:

1. In the Subject box, type the name of the task. This is actually the only field you
have to enter to create a task.

2. The Start Date is when you want to begin working on it (the day you want it to
appear on your daily to-do list). If you only fill in the Due Date, the Start Date is
left at “None,” which is read as if you are starting the task today. (Same text
tricks apply.) HINT: If you leave the Start Date and Due Date blank, it will still be in
your Task list as a master task list item.

3. The Due Date is when the task must be finished. You can enter a specific date,
or you can type in a text string, and Outlook will figure out what date
corresponds with it: “The first Friday of July,” or “three weeks from Friday,” and
it will autofill the correct date.

Status; | Mok Started

4. Status (optional) is where you are on the Task. If rioity Fﬂm“

Completed
Waiting on someone glse
Deferred

n Frogress
you haven’t started, leave it on Not Started. e

5. Priority (optional) by default is normal, but you can choose high or low. No real
functionality here.

6. % Complete (optional): as applicable

7. Reminder (if you want the reminder pop-up box to come up before it’s due).
We'll soon see that this isn’t necessary, because you’ll use the built-in reminder.

8. Text box: enter notes and instructions about the task and any other information
you’ll need to complete it (hyperlinks, etc.).

9. There are many other options under the Task, Insert, Format Text, and Review
tabs.
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B. Change the View in Your To-Do Bar to Make the Daily To-Do List
Work Via Start Date.

1. Make sure your To-Do bar is showing on the right. If it’s not, click the arrows to
expand. (You can always collapse it again if it’s in the way.) The To-Do bar
stays open whether you're in Calendar, Contacts, Inbox, etc., so you can always
refer to your to-dos.

2. Under the Arranged by: option, select Start Date and Show in Groups. This will
make sure you see the task on the day you need to begin working on it, not the
day it’s due!!

C. Change Your To-Do Bar Preferences.

1. Under the File tab, click Options.
2. Select Advanced.

Outlook Options (Bl

General \J » . . .
#'§ Options for working with Outlook.

Mail
Calendar Outlook panes
Contacts = Customize Outlook panes. Navigation Pane...
Tasks Reading Pane...
Motes and Journal

3. Under Outlook panes, select To-Do Bar.

To-Do Bar Cptions @
[¥]sh

Mumber of month rows: 1

Show Appointments
Show All Day Events
Show Details of Private Ttems

Show Task List

[ OK ][ Cancel ]

4. Check all boxes and set options as desired.
5. Click OK.
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D. Convert an Email into a Task.

By Laura Stack, MBA, CSP

DISCUSSION: why flagging email only creates a “To-Do” and not a Task; why is this a bad
idea and why should you instead convert it into a Task?

1. Right-click on the email (or open the

e

Quick Steps

=
e

Move
Karore
Junk
Delet

X

Linkedln Gi
»  Group: Le:
»  Discussion

The Intemational 51
“oeoole have an ac 1)

email).

Subsect
and Training Profess... New comment on ‘Stress”

& 500ty of ARSOOINN Ext... New comment on Stess
Development & Training Forum New comment on “Stress”

Neew comment on “Stress”
RE: Follow up on your offer 1o
RE: Tips and Tricks contributo

Inbox
@ Computer
Deleted Rems
Calendar
Contats
Friends

Lauea's personal

Jouma:

-
O Seemorcabou

2. Select Move from the short cut menu
under the Move group).

3.

4. Click OK.

5.

(or if you're viewing the email, select Move

Select Tasks from the list (or Other Folder if you've not done this step before).

This will create a new Task (your email will be in the text portion of the Task,

including all attachments; if you opened the email, you'll also have the text of the

email in the Task underneath):

& |= Mew comment on "Stress” - Task o 0
File Task Insert Format Text Review & 0
= = A e’ [ (&) Private
= = B U . £
1 ¥ HighImportance
Save & Delete Forward Task |Details Mark  Assign Send Status | Recurrence | Categorize Follow
Close Complete Task Report - up- ¥ LowImportance
Actions Show Manage Task Recurrence Tags Zoom Ink
Subject: Mew comment on “Stress”
Start date: MNaone - | Status: Not Started -
Due date: MNone + | Priority: Naormal - % Complete: |0%
[ Reminder: Mone Mone iJ{ owner Laura Stack
iz
% &
Mew comment on
"Stress”
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6. Update all of the information accordingly. Don’t forget —use the Start Date to
indicate when you want the Task to appear on your To-Do Bar under your
Today flag (daily to-do list). You can set a reminder here or even type notes to
yourself.

7. Click the “Save and Close” button. The email will be moved from your inbox to
your tasks (the original is in your Deleted Items if you want to file it, or create a
copy first before you move it to a task).

Bottom line, does flagging an email create a Task? NO!!! It simply adds the message to
the To-Do bar. You can’t assign it to others or track its status, and if you
complete/unflag it, the to-do is gone, but the email remains in the Inbox. This is how
email piles up! Flags also sort by DUE DATE, not start date, so often you are reminded
too late to complete it. If you MUST flag email instead of converting them to Tasks,
right-click the flag and select CUSTOM, so you can specify Start and Due Dates.

E. Assign a Task to Someone Else.

1. Select Tasks click New Task.

2. In the Manage Task group, select Assign Task.
v b M
e =
Mark  Assign Send Status!
Complete Task Report E
Manage Task ;
3. Select the delegate using the TO field (just as you would with an email).
4. Enter the task in the Subject field.
5. In the Start Date and Due Date fields, enter the desired dates or select from the
calendar.
6. Attach any files needed for the task.
7. Type a message with instructions in the Note area.
8. If you would like to keep an updated copy of the task on your task list or receive

a status report when the task is complete, check the appropriate check boxes.
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File Task Insert Format Text Review
XL & @

Sawe & Delete Task | Details Cancel Address Check

Close Assignment Book Mames
Actions Show Manage Task Mames
To... Becca @TheProductivityPro.com;
_
Send Subject: CEM - cloud option
Start date: Maone v | Status:
Due date: MNone + | Priority:

Keep an updated copy of this task on my task list
Send me a status report when this task is complete

9. Click Send.

NOTES: The recipient can either Accept or Decline your task request, just like a meeting
request. If accepted, it goes right to Tasks. They now own it, and you can’t make
changes. You can also Assign a Task when you Move it to Tasks from the Inbox.

F. Group Assigned Tasks by Person Responsible.
1. From the Current View Group, select by Person Responsible.

2. If not visible on the screen, click the More arrow in the lower right corner to
expand the View choices.

To-Do List - Madlbex - Lavea Stack - Microsoft Outiock

View Adddns
¥ |y M PLAN 24 |
/ v )
: By Category | By Person Task Timell Detalled
| ¥ Y v/
mple List To-Do List Priontize Actve
P
D! @ Task Subject Requested By Owner J vy \ A ‘.
Click here t : ¢ .
ompieted day ext 7 Day Overdue
i
4 Owner: Becca Fletcher (I fem) »
E ; o) )
38 @ Introduan., Becca Fletcher Assigned  Server Tasks
Idanage Views
4 Qwner: Beccad TheProdutmtyPro.com (1 ites
& Sove Current View A5 a New View
38 6 Newcomm, Becca@TheProguctivityPre
Apply Current View to Other Task Folgers

Owner: Laura Stack (105 Aems)

3. Open and close the tasks for each person as desired to view.
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G. Modify Your Master Categories List.

1. Start a New Task.
2. In the Tags group, click Categorize.
3. Select All Categories.

Color Categaories ﬁ

To assign Color Categaries to the currently selected items, use the checkboxes next to each
category. To edit a category, select the category name and use the commands to the right.

Shortout key - Mew...

Renarme

[C][] Objectives

m

[[1[[] .Projects Business Delete

[C][] 1:1Becca Color:

‘g yli=mmc

Dm= RO
) Shortcut Key:

[T [l Business

D D CD"EEQUE

(] [l Competition

[] [[] Coordinate marketing with Random House
[ | Create summer BBQ

(] [l Dillwor il

1 . - Ima -—

[ Ok ] [ Cancel

4. In the Color Categories dialog box, rename the categories to reflect your projects,
committees, people, geographical areas, etc., that describe the categories of tasks
you work.

5. Delete any that aren’t in use to make your list smaller (you can always add them
back in later).

6. If you like a particular color that isn’t in use, select New... and pick the color
from the list.

7. Hint: if you put a period in front of the category name, it goes to the top of the
list. You can create a Category for each project and add it to your master project
list. Here are some categories you could use:

e .Projects: Business
e .Projects: Personal
e .Ideas

e .Objectives
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H. Tag a Task with a Category.

D=

4.

Create a New Task (for each step of the project). [ %P (&) Private

In the Tags group, click the Categorize button. [ ¥ HighImportance
. Categorize Follow

Select the appropriate Category name or names . Up- ¥ LowImportance

(you can tag a task with multiple categories). Tags

Save and Close.

Hint: create an overall project plan in one task, tagged with the .Projects: Business
category, and then copy/ paste each individual step of the project into its own Task,
Categorized by the project name itself.

I. Group Tasks by Category. The view is simply how you're looking at your data
for that filter (how you arrange it).

D=

Select Tasks in the Navigation Pane.
Click the View tab.
In the Arrangement group, click Categories (or any other desired view).

] =
HE Categories v Start Date v Due Date 4 Type
i =
? Importance =) Assignment _4’ Modified Date —

Arrangement

Open and close the Categories by clicking the arrow next to each category to see
all open tasks for that category/ project.

01| | subject
Click here to add a new Task

» (Categories: [none) (68 items)

» 0 Categories: Ideas (27 items]

=0 Categories: .Projects Business (1 item)

a [ Categories: Coordinate marketing with Random House 3 items)
& [0 122, Write copy
& [0 121,  Send photos
= i mpp ¥ Request post cards

| Categaories: Find Mare Time (3 items)

o0 Categories: SUPERCOMPETEMT (1 item)
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J. Filter the View to Sort Your Tasks. The Current View filter shows you a

subset of your tasks. Then you can click the View tab to arrange them in a particular
order.

By Laura Stack, MBA, CSP

1. Select Tasks from the Navigation Pane.
2. From the Home tab, under the Current View group, select Simple List.

Iy 1 ¥

Simple List To-Dro List Prioritized Active =

Current View

3. Click the Subject column. Hint: If you always start the Subject with the same
project name, code, or numbered list, all your tasks can now sort in alphabetical

order and stay together:
i‘i [ FMT:1. Coordinate marketing with Random House
2‘]' [ FMT: 2. Coordinate internal marketing effort for book sales
i’]’ [ FMT: 2. Coordinate internal marketing effort for book sales
i’i [T FMT: 2.2 Create special pre-publication order form
i’i [ FMT:3. Hire new part-time media employee to help in PR effort
i’i [ FMT: 4. Build media awareness and relationships
i‘i [ FMT: 5. Develop Web site enhancements to support book
2‘]' [] FMT:6. Create support materials to sell speaking engagements to clients

4. Or click Completed Tasks for example in the Current View, then click the View

tab and in the Arrangement group, select Date Completed to see the most recent
you completed.

K' Change the TaSk Optlons' Geners! g Change the settings that track your tasks and to-do items.
Mail
Calendar Task options
1. Ul’lder the TOOIS menu, Select Contacts . *,’ [[] set reminders on tasks with due dates
. [ ) petautt remingertime: [2:00 M v | @&
Opthl’lS. Keep my task list updated with copies of tasks [ assign to other people
. Notes and Journal Send status report when I complete an assigned task
2. Next to the Task Options . P
button, set the default reminder Mabile Completetas colr
box time (I use 9:00). tangusss Set Quick Click lag
Advanced
3. Select Task Options. S |

By ask workin jours per day:
Choose colors and check boxes. Quick Access Tootoar || ] o workmahoursperda 18

Ab(|4p

Task working hours per week: |40
Add-Ins
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Educational Resources by Laura Stack

Subscribe to the Productivity Minute! Watch a one-minute personal performance video each week,
delivered via email: www.theproductivitypro.com/productivityminute/

eBook of screenshots of amazing Microsoft Outlook Task Tricks by Laura Stack:
www.TheProductivityPro.com/download.htm

Download the Laura Stack app for a free eBook! www.TheProductivityPro.com/app

What to Do When There’s Too Much to Do book site: www.TheProductivityPro.com/WhatToDo
Laura’s YouTube channel: http:/ /www.youtube.com/theproductivitypro

Link with me! http:/ /www.linkedin.com/in/laurastack

Join our LinkedIn Group, The Productivity Pro® Alumni, to exchange ideas and insights:
http:/ /www.linkedin.com/e/vgh/1259217/

Follow me! http:/ /twitter.com/laurastack

Become a Fan of The Productivity Pro®: www.facebook.com/productivitypro

Sign up for my free weekly productivity newsletter, The Productivity Pro®:
http:/ /www.theproductivitypro.com/r subscribe.htm

Laura’s blog: http:/ /www.theproductivitypro.com/blog/

Over 150 free articles for download and reprint for your company website, newsletter, or blog:
http:/ /www.TheProductivityPro.com/articles

12 hours of Microsoft Outlook online video training with workbooks:
http:/ /www.TheProductivityPro.com/outlook

FREE downloadable worksheets, checklists, and resources:
http:/ /www.theproductivitypro.com/r free stuff.htm

Take the quizzes FREE from Laura’s books: http:/ /www.theproductivitypro.com/r_quizzes.htm

Get a FREE tip of the day via email: http:/ /www.theproductivitypro.com/r_subscribe_365Tips.htm

Resources for purchase (books, CDs, DVDs, self-study audio, video training, MP3s etc.):
http:/ /www.theproductivitypro.com/t productivity tools.htm
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